
 

 

                                                    Assignment 1 

Q1.Four Fundamental parts of computer are:- 

1) Input Unit  

2) Output Unit 

3) Memory Unit 

        4)    Central Processing Unit (CPU) 
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                                     Figure: Diagram of four fundamental parts of computer. 

Q2.         Base on the size and capacity, computer are classified as follows: 

              1)Super Computer 

                          The computer have thousand of Processors, because of their extra ordinary 

speed, accuracy and processing power, super computers are well suited for solving highly complex 

problems and huge amounts of calculations. 

Example: Roadrunner, Jaguar etc. 

                2)Mainframe Computer: 

                              This Computers are very large often filling an entire room and can process 

thousands of millions of instructions per second. These computers are capable of supporting hundreds 

of thousands of users simultaneously. Some of functions perform by a mainframe include flight 

scheduling, reservation and ticketing for an airlines etc. 

     

 Example: IBM main forms Z13, IBM system Z9 Mainframe.    
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              3)Mini computers:  

                                  Mini computers are much smaller then mainframes. Sometimes referred to 

as Midrange sized business as their servers. 

  Example: Apple IPad, CDC 160A. 

              4)Microcomputers: 

                                   Microcomputers are the most frequently used type of computer. It is also 

known as PC (personal computer).A microcomputer is a small computer system designed to be use by 

one person at a time.  

Example: Desktop computers, Laptops. 

 

Q3.Generation in Computer terminology is a change in technology a computer is being used. Her are 

four generation in computer. 

➢ In first computer System, vacuum tubes are used. 

➢ Translators are used in Second Generation. 

➢ Integrated circuit technology were used in 3rd generation. 

➢ In the 4th Generation microprocessors are use. 

 

  



 

 

 

 Q4.The different between Volatile and Non-Volatile are:- 

 

                    

                     Volatile                  Non-Volatile 

• It is a computer storage 
that only mountain is its 
data while the device is 
powered. 

• Example: RAM 

• Primary Memory has 
limit storage capacity and 
its volatile. 

• It is a type of computer 
memory that has the capacity 
to hold saved Data if power is 
turn off. 

• Example: ROM, Hard disk etc. 

• Secondary Memory Provides 
permanent storage of data 
and in bulk capacity. 

  

Q5. 

           System Software        Application Software      Open Source Software(OSS) 

❖ It is a type of software 
that is design to run a 
computer’s hardware 
and application 
Programs. Software like 
operating system 
compilers, editors and 
drivers etc. come under 
this category. A 
computer cannot 
function without the 
presence of system 
Software. 

❖ It is software create for 
a specific purpose 
users. It can be called 
application or simply an 
app. 

Example: Ward Processor, 
accounting app etc. 

❖ It is a type of computer 
software is which 
source code is released 
under license in which 
the copyright holder 
grants user rights to 
study charge and 
distribute the software 
to anyone and for any 
purpose. 

 

  



 

 

Q6. A) 

             The steps involved are: 

1) We click the Microsoft office button. 
2) We select new. The new document dialog box appears. 
3) We select blank document under the blank page and recent selection. It will be highlight by 

default. 
4) We click create. A new black document appears in the word window. 
5) To save the document, we click again the Microsoft office button. 
6) We click Curls or save .The save as dialog box appears. 
7) We select the location where we want to save the document using the drop-down menu. 
8) We enter the file name “Yourself” for the document. 
9) We click the save Button. 

 

B) 
➢ Steps to change the font size: 

1) We select the text or sentence we want to modify. 
2) Left Click the drop down arrow next to the font size box on the home tab. The font size drop 

down menu appears. 
3) We move cursor over the various font size. A live preview of the font size will appear in the 

document. 
4) Left-Click the font size we want to use. The font size will change in the document. 

 

➢ Steps to change the font Color: 
1) We select the text or sentence we want to modify. 
2) Left-Click the drop down arrow next to the font color box on the home tab.The font color menu 

appears. 
3) We move cursor over the various font colors’ line preview of the color will appear in the 

document. 
4) Left-Click the font color we want to use. The font color will change in the document. 

 

➢ To highly (in yellow) the line that reads “need to get IMS’s”. 
1) We select the line that needs to get IMS’s address. 
2) We click the highlight command and select yellow color in the font group on the home tab.  

 

Q7.        The steps involve in it are:- 

1) We click the Microsoft office button. 
2) We select new. The new document dialog box appears. 
3) We select blank document under the blank and recent section. It will be highlighted by default. 
4) We click create. A new blank document appears in the word window. 
5) We create the given documents from the question. 



 

 

6) We select the text “MS WORD” and change the font size by clicking on the font size box on the 
home tab. 

7) We select the text “MS WORD “to change the font color into red, by clicking on the font size box 
on the color menu. 

8) We select the text “word processor “and underline it by clicking the underline command in the 
font group on the home tab. 

9) We select the text “MS WORD” to change the font style into italic by clicking italic command. 
10) We select the text we want to format as a list and click the bullet commands on the Home tab. 
11) To change the font color of the text “creating and saving” into blue and red respectively, by 

clicking on the font color command, again we select the text “and “and click on strike through 
command. 

12) We select the text “printing any type of document” and change the font style into bold by 
clicking on the font style command. 

13) We save the file name as “MS WORD” by clicking the Microsoft office button and select save as. 
14) We select the location where we want to save the document using the drop down menu. 
15) We click the same bottom. 

 

Q8.    The steps involved are:- 

1) We create given document in MS Word. 
2) We select the text where we want to format and click on the subscript and superscript 

command on the home tab. 
3) We save the file name as ‘equations’ by clicking the Microsoft office bottom and select save as. 
4) We select the location where we want to save the document using the drop-down menu. 
5) We click Curls or ‘Save’ bottom. 

 

Q9.    The steps involved are:- 

1) We select the existing highlight text that we want to convert. 
2) We select the insert tab. 
3) We click the table command. 
4) We select the convert text to table from the menu. If dialog box appears. 
5) We click OK.Then the text appears in a table. 

 

Q10.    The steps are: 

1) We place our insertion point in the document where we want the table to appear. 
2) We select the insert tab. 
3) We click the table. 
4) We drag our mouse over the diagram squares to select the number of columns and rows in the 

table. 
5) Left-Click the mouse and the table appears in the document. 
6) We enter the text into the table. 

Q13.  A)  



 

 

❖ To modify column width of worksheet: 
I. Select a column or a range of columns. 

II. Select a Home tab and in cells group, select format. 
III. Click on column width and type the width for the column. 
IV. Select OK. 

❖ To modify the row height of a worksheet. 
I. Select a row or a range of rows. 

II. Select a Home tab and in the cells group, select Format. 
III. Click on row height and type the height for row. 
IV. Select OK. 

❖ To delete rows and columns of a worksheet. 
I. Select the desire row or column. 

II. Right-click and select Delete. 

b)         

❖ Absolute reference: 
An absolute reference in excel means there is a fixed point of reference applied to a cell or a 
formula. This shows the return value will always stay the same no matter where the cell or 
formula moves to – within the same sheet or across different sheet. 
This refers to a fix point of reference is constant, and involves the use of dollar sign ($) in the 
formula. 

❖ Relative Reference: 
It is the default cell reference in Excel. It is simply the combination of column name and row 
number without any dollar ($) sign. When we copy the formula from one cell to another the 
relative cell address changes depending on the relative position of column and row. C1, D2, E4, 
etc. are example of relative cell references. Relative reference are use when we want to perform 
a similar operation on multiple cells and the formula must change according to the relative 
address of column and row. 
This refers to a relative point of reference, is constantly changing and dollar sign ($) is absent in 
the formula. 

❖ Cell Address: 
A cell address is a combination of column letter and a row number that identifies a cell on a 
Worksheet. 
For example A1 refers to the cell at the intersection of column A and row 1. 
B2 refers to the second cell in column B, and so on. 
 
When we use in formula, cell references help Excel find the values the formula should calculate. 
For instance. 

• To pull the value of A1 to another cell, we use the simple formula : A1 

• To add up the values in cells A1 and A2 we use : A1+A2. 
 

Q14. A) The tools available to customize our PowerPoint presentation are: 

a) Perspector. 
b) Pivot Viewer. 
c) Autodesk 3DS Max. 
d) Visual Bee PowerPoint Add-In. 



 

 

e) Smart Art. 
f) Animations and Transitions. 
g) Wordle. 
h) Cacoo. 
i) Oomfo. 
j) Clip champ. 

 

B)  

❖ To open Blank presentation: 
I.    Open power point presentation using ‘Run ‘command. 

II.    Select the ‘Blank Presentation’. It is opened. 
❖ Save the presentation as ‘Lab1.pptx’. 

I.    Select the ‘File’ on Tab Bar. 
II.    Click on ‘Save as’ option. 

III.    Click o0n Desktop as a choice. 
IV.    Type the name ‘Lab1.pptx’. 
V.    Click the ‘Save button’. 

Q15.   

❖ Title slide and bullet list: 
I. Open Power Point Presentation. 

II. Select the Home tab. 
III. Click the dropdown button on ‘New Slide’ at toolbar. 
IV. Select the slide having title slide and Bullet list. 

❖ Inserting Excel Sheet: 
I. Open the slide where you want to insert the Excel sheet. 

II. Select the ‘Insert tab’. And Click on ‘Object’ on tool bar. 
III. Select the ‘Microsoft Excel Worksheet’ object type. 
IV. Click the ‘OK’ button. 

❖ Clip art and Text. 
I. Select the Insert tab. 

II. Select the ‘Pictures’ or ‘Online Pictures’ on toolbar. 
III. Choose the appropriate art for the topic. 
IV. Click on the ‘Insert’ Button. 

❖ Slide show effects: 
I. Select ‘Design Tab’ for Themes, Variants and slide size. 

II. Select ‘Transition Tab’ for Cut, Fade, Push, Wipe, Split, Reveal, Shape, Flash, etc. for slide 
Effects. 
 

 

 

Q16.      The difference between Machine language and High level language are:- 

                      Machine language                  High level language  



 

 

1. A computer program language 
consisting of binary instructions which 
a computer can respond to directly. 

2. This language makes fast and efficient 
use of the computer. 

3. AU memory address has to be 
remember. 

 

1. A High level language is a programming 
language that enables development of 
a program in a much more user-
friendly programming context. 

2. High level languages are programmer 
friendly. They are easy to write, debug 
and maintain. 

3. It takes additional translation times to 
translate the source code to machine 
code.  

 

 

Q17.      The different data types of C programming language are:- 

A. Char- The most data type in C. It stores a single character and requires a single byte of 
memory in almost all compilers. 

B. Int- As the name suggests, an int variable is used to store an integer. 
C. Float-It is used to store decimal numbers (numbers with floating point value). 
D. Double-It is used to store decimal numbers (numbers with floating point value but its range 

of value is high in comparison to float. 

Q18.    A) Y= 33 

             B) Y= 30 

             C) C= 16  

Q19.   A) If – else statement 

• If statement can be followed by the optional else block of statements, which executes when the 
Boolean Expression is false. 
Syntax 
If (expression) 
  { 
     True block of statements; 
  } 
Else 
 { 
     Else block of statements; 
 } 
 

     C) while loop: 

• Basic Syntax of while loop is as follows: 
    While (condition) 
               Single statement; 
OR 
       While (condition) 
        { 



 

 

        Block of statements; 
     } 

D)  do – while loop 

        Unlike for and while loops, which test the loop condition at the top of the loop, the do-while loop 

in C programming checks its condition at the bottom of the loop. A do-while loop is similar to a while 

loop, except the fact that it is guaranteed to execute at least one time.  

           The syntax of a do-while loop in C programming language is – 

 

 

 

              Notice that the conditional expression appears at 

the end of the loop, so the statement(s) in the loop 

executes once before the condition is tested. If the condition is true, the flow of control jumps back up 

to do, and the statement(s) in the loop executes again. This process repeats until the given condition 

becomes false. 

             A do-while loop is a kind of loop, which is a kind of control statement. It is a loop with the test at 

the bottom, rather than the more usual test at the top. This kind of loop is most often used when the 

test doesn’t make any sense until the statement have been performed at least once.  

 

 

 

Q20. 

Ans. 

A) Ans. IMS Ghaziabad 

B) IMS Ghaziabad  

IMS Ghaziabad 

C) Largest number is 100 

 

 

do { 

   statement(s); 

} while (condition); 


